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If	you	want	to	edit	photos	or	create	digital	artwork,	GIMP	is	a	great	free	alternative	to	Photoshop	Elements	or	Photoshop	CS3.	Download	this	image	of	my	best	friend,	Echo.	Give	it	a	new	name	(so	you	don’t	overwrite	the	original)	and	click	the	Export	button.	If	you’d	like	to	keep	the	aspect	ratio	size	the	same,	make	sure	the	dimensions	are	linked.			For
this	image,	unlink	the	dimensions	and	type	in	the	Height	of	1200.	GIMP	photo	editing	software	is	the	number	one	FREE	alternative	to	Photoshop.	My	safety	features	won’t	let	me	download	the	software	unless	I	right-click	on	the	download	link	and	choose	“Download	file.”	It	also	opens	up	a	new	website	just	for	downloading.	This	will	create	a	square
aspect	ratio.	How	to	Install	GIMP	Setting	up	GIMP	on	your	computer	is	a	breeze.		First,	navigate	to	gimp.org	to	download	the	app	for	your	operating	system	(Mac	or	Windows).	Search	for	your	file	and	click	the	Open	button.			Another	method	for	opening	a	file	is	locating	it	via	your	systems	folder,	clicking	on	the	file,	and	dragging	it	over	the	GIMP
interface.	Step	3	Type	in	a	width	of	1200px,	which	is	the	recommended	width	per	Sprout	Social.		Hit	the	TAB	key	on	your	keyboard	and	GIMP	will	auto-update	the	Height	to	be	in	proportion	to	the	original.		NOTE	from	Darlene:	I	recommend	using	a	size	of	2048	pixels	on	the	long	side	for	Facebook	as	I’ve	had	good	luck	with	that	resolution	and	other
sites	recommend	that	size	Next,	type	in	72	for	both	the	X	and	Y	resolution.	Now	that	you	know	how	to	open,	resize,	crop,	and	export	your	images,	the	next	step	in	your	journey	should	be	mastering	layers	in	GIMP!	Layers	are	essential	for	everything	you	do	in	GIMP,	and	they	work	a	little	differently	than	in	other	photo	editing	software.			Read	Next:	A
complete	guide	on	GIMP	layers	that	shows	you	how	to	use	them	and	answers	the	7	most	asked	questions	about	GIMP	layers.	In	this	article,	you’ll	learn	how	to	get	started	with	GIMP!	What	you’ll	learn	For	starters,	you’ll	discover	where	to	download	GIMP	and	how	to	install	it.	Since	your	intended	output	is	the	internet,	you’ll	need	to	save	it	with	a	file
format	compatible	with	online	use.	For	Windows	machines	Double	click	the	.exe	file	that	you	downloaded	and	follow	the	on-screen	prompts.	Step	2	Make	sure	the	chain	link	icon	next	to	Width	and	Height	is	activated	(linked).	Click	the	OK	button	to	resize	your	image.	If	you	have	any	comments	or	questions	please	post	them	in	the	comment	area	below.
Click	below	to	learn	more!	This	post	may	contain	affiliate	links.	The	box	shown	to	the	left	should	appear.	Click	on	the	drop	down	menu	and	choose	a	document	size,	preferrably	one	with	300	DPI.	In	addition	to	our	best-selling	courses	and	our	world-renowned	GIMP	video	tutorials,	we	also	offer	tons	of	help	articles	to	help	you	learn	a	variety	of	subjects
–	including	various	free	software	like	GIMP,	Darktable,	and	Inkscape.	Anything	on	the	outside	of	the	outline	will	be	cut	from	the	image.	Want	to	take	your	GIMP	learning	to	the	next	level?	Once	downloaded,	open	it	in	GIMP	using	the	directions	above.	If	you’re	a	Mac	owner,	check	back	next	week	for	your	own	GIMP	installation	tutorial!	We'll	send	you
articles	&	tutorials	right	as	we	publish	them,	so	you	never	miss	a	post!	Unsubscribe	here	at	any	time.	Then	you’ll	then	dive	into	the	GIMP	interface	to	customize	it	for	your	needs	and	locate	all	the	tools.			Finally,	you’ll	learn	about	opening,	saving,	and	exporting	your	files	out	of	GIMP.	Just	click	the	“Replace”	button	to	update	GIMP.	Intended	output
Let’s	say	you	have	an	image	that	is	full	size	right	from	your	camera	and	wish	to	share	it	on	Facebook.	To	adjust	the	composition,	click	on	the	inside	of	the	outline	and	move	it	into	your	preferred	position.	By	default,	most	of	the	options	will	be	selected.	Quick	Tip	You’ll	notice	an	option	to	download	GIMP	2.99.x.	This	is	an	unstable	beta	version	and	isn’t
recommended	for	everyday	use.	Once	it’s	open,	play	around	a	bit.	(It	should	be	right	at	the	top.)	Click	the	download	link	to	start	your	download.	(The	name	GIMP	is	an	acronym	for	GNU	Image	Manipulation	Program,	by	the	way.)	To	download	and	install	GIMP	on	your	PC,	the	first	thing	you’ll	need	to	do	is	go	to	www.gimp.org	and	click	on	the
download	button	near	the	top	of	the	page.Quick	announcement	-	EmptyEasel	has	created	a	quicker,	easier	way	for	artists	to	have	their	own	art	website.	The	version	below	is	low	res,	and	just	for	example	purposes.	If	this	happens	to	you,	don’t	worry,	it’s	normal.	Get	access	to	premium	tutorials,	course	and	class	lectures,	and	downloadable	resources
like	the	GIMP	Help	Center	app,	GIMP	Book	of	Layers,	and	social	media	templates.	Isn’t	he	cute?	NOTE:	You	may	also	be	interested	in	EE's	step-by-step	drawing	guide	for	artists.	Your	journey	with	GIMP	has	just	begun	You’ve	come	to	see	that	getting	started	with	GIMP	is	very	straight-forward.	When	it	asks,	click	“Run”	then	click	“Install.”	This	will
bring	up	the	GIMP	Setup	Wizard—just	click	the	“Next”	button	until	you	see	the	final	screen,	where	you	can	click	“Finish.”	As	long	as	the	“Launch	the	GIMP”	box	is	checked,	GIMP	will	open	right	away,	and	there	will	be	a	new	shortcut	icon	on	your	desktop	for	later.	Renaming	suggestion:	To	rename	our	new	image	file	you	can	just	add	a	dash	and	a
word	or	something	to	indicate	it’s	a	new	and	different	file.	GIMP	will	auto-update	the	software	accordingly	and	you	will	not	lose	any	settings.	Depending	on	your	computer	resources,	it	could	take	a	couple	of	minutes	or	longer	to	install.		Once	the	installation	is	completed,	locate	the	GIMP	app	and	make	a	desktop	shortcut	for	easy	access.	Again,	click
here	to	open	the	picture	of	Echo	in	a	new	tab,	at	full	resolution.	That	will	keep	the	image	proportions	locked	so	it	doesn’t	get	stretched	out	of	shape.	To	use	this	file	format,	you’ll	need	to	export	instead	of	saving.	From	a	2-hour	GIMP	Basics	tutorial,	to	how	to	create	pixel	art,	to	how	to	recolor	your	photos,	we	truly	offer	a	wide	range	of	GIMP	tutorials
for	all	skill	levels.	In	this	case,	you	should	use	the	JPG	format.	How	to	save	your	image	Now	that	your	image	is	resized	and	cropped,	it’s	time	to	save	it	as	a	new	file.	At	its	current	size,	it’s	too	large.		Let	me	show	you	step-by-step	how	to	resize	and	crop	your	image	for	online	use.	Add	Additional	Tool	Panels	The	two	most	used	inner	panels	in	GIMP	are
the	Layers	panel	and	the	Tool	Options.	As	I	write	this,	GIMP	version	2.4.6	is	the	“stable	version”—you’ll	want	the	latest	stable	version	as	well.	In	the	folder	that	just	opened,	double-click	on	on	the	GIMP	Icon.	I’d	recommend	downloading	the	stable	version	instead	(2.10+).	Once	you’re	happy	with	how	it	will	be	cropped,	click	the	Resize	button.
Customize	the	GIMP	Interface	When	you	open	GIMP	for	the	first	time,	the	interface	will	be	in	Single	Window	Mode.	You’ll	probably	want	to	save	the	software	to	your	program	files	folder,	so	when	asked,	click	“Save”	and	navigate	to	“Program	Files.”	Once	the	download	is	complete,	click	on	“Open	Folder.”	You	should	see	something	similar	to	the	image
below.	But	it’s	time	to	get	your	hands	dirty	with	GIMP	by	resizing	and	cropping	an	image.	We	have	plenty	of	free	GIMP	tutorials	for	all	skills	levels.	Next,	follow	the	steps	below	for	your	computer.	For	Mac	computers	Once	you	have	the	GIMP	app	downloaded,	double	click	the	file	to	start	the	process.		After	the	new	install	window	appears,	drag	the
GIMP	icon	over	the	Applications	folder.		Then	release	your	mouse	button	and	it	will	begin	installing.	For	example,	my	operating	system	is	Windows	XP,	so	the	option	below	works	for	me.	If	needed,	you	can	move	the	panel	by	clicking	on	its	tab	and	dragging	it	to	a	new	location.		How	to	open	images	in	GIMP	Opening	an	image	in	GIMP	can	be	done	by
going	to	File	>	Open.	Use	the	link	above,	to	download	the	full-resolution	version	of	Echo	to	work	with.	This	time,	the	file	will	include	the	original	file	extension,	JPG.	Articles	are	available	in	over	30	languages.	At	first,	you	would	think	that	saving	would	be	as	easy	as	going	to	File	and	choosing	Save,	Save	As,	or	Save	a	copy.		However,	that’s	not	the
case!		Each	one	of	those	options	is	for	saving	a	file	with	multiple	layers.	The	black	outline	overlaid	on	the	image	represents	which	part	will	be	cropped.	Through	any	one	of	those	three	options,	you	will	be	unable	to	save	it	in	any	other	format.	GIMP	will	magically	determine	your	operating	system	and	will	provide	the	appropriate	link	for	you.		Click	that
big	‘ole	orange	button	to	start	the	download.	In	the	future,	to	update	to	the	latest	version	of	GIMP,	download	it	again	and	follow	the	same	install	steps.		Your	operating	system	will	warn	you	that	the	application	is	already	installed	and	will	ask	if	you	wish	to	continue.	Next,	you’ll	have	a	new	window	labeled	“Export	Image	as	JPEG,”	and	you’ll	have	some
choices	to	make.		First,	set	the	quality	between	80	–	100.	How	to	resize	and	crop	images	Here	is	the	moment	you	have	been	waiting	for	your	whole	life!	Well,	maybe	not	that	long.	This	mode	divides	the	interface	into	three	separate	panels	as	follows:	ToolboxImage	windowTool	Panels	To	combine	all	three	into	a	singular	window,	go	to	the	top	menu	and
choose:	Windows	>	Single-Window	Mode.		Then	all	three	will	be	combined	into	a	single-window	which	is	what	I	recommend.	Then	just	right-click	to	download	it.	Once	you	release	your	mouse	button,	the	image	will	be	added	and	opened	inside	GIMP.	Oh,	and	as	a	bonus,	you’ll	learn	how	to	resize	and	crop	an	image	with	GIMP.	Step	1	Go	to	the	top
menu	and	click:	Image	>	Scale	Image.	For	example,	if	your	original	file	is	called	Echo-01.jpg,	call	the	exported	one	Echo-01-Facebook.jpg,	then	you	know	what	its	intended	use	is	and	you	can	find	it	by	searching	for	the	term	“Facebook”.	Davies	Media	Design	offers	several	GIMP	courses	and	classes,	ranging	from	a	30	hour	GIMP	Masterclass	on	Udemy
to	shorter	classes	on	Skillshare.	If	the	panels	(within)	are	stacked,	you	can	make	the	top	or	bottom	taller	or	shorter	by	clicking	on	the	three	dashed	lines	between	them.	Step	4	To	crop	your	image,	go	to	the	top	menu	again	and	choose:	Image	>	Canvas	Size.	Before	finalizing	the	crop,	you	need	to	tell	GIMP	how	to	crop	it	for	the	composition.	This	type	of
file	will	have	an	extension	of	“.XCF”.	If	you’re	just	getting	started	with	GIMP,	this	tutorial	will	be	perfect	for	you.	A	quick	way	to	start	a	new	document	is	to	hold	down	the	“Control”	key	on	your	keyboard	(CTRL)	and	tap	the	“N”	key.	At	this	point,	even	though	GIMP	is	running,	there’s	no	document	open	yet.	To	update	GIMP	in	the	future,	download	the
latest	version	and	install	it	as	before.	Want	to	learn	beyond	our	free	tutorials?	Unless	you	have	a	reason	to	uncheck	these	or	need	to	adjust	the	Advanced	Options,	just	click	Export.	Click	and	drag	to	the	left	or	right	to	make	the	panels	broader	or	narrower.	It	will	open	in	a	new	tab.	There’ll	be	plenty	more	GIMP	tutorials	coming	up,	so	don’t	worry	if
everything	looks	strange	at	first.	There	are	additional	panels	that	contain	options	for	customizing	your	tools	as	well.		To	add	different	panels,	go	to	Windows	>	Dockable	Dialogs,	and	choose	a	panel	to	open	it.			The	new	panel	will	auto	open	in	the	main	right	panel.	Alter	Panel	Size	Both	the	left	and	right	panels	can	be	resized	as	needed.	In	the	middle	of
the	“Set	Image	Canvas	Size”	window,	you’ll	see	a	preview	of	how	the	image	will	be	cropped.	As	well	as	the	individual	tabs	or	sections	within	the	panels.		To	resize	the	main	panels,	locate	the	three	dashed	lines	(indicated	in	red	below)	on	the	inside	of	each	one.	Export	your	image	as	a	JPG	To	export	your	file,	go	up	to	the	menu	and	choose:	File	>	Export
as.	Click	here	to	learn	more	and	get	a	simple	art	website	of	your	own!	Since	all	computers	have	different	operating	systems,	the	next	thing	you	will	need	to	do	is	choose	the	appropriate	one	for	you.	They	share	a	lot	of	the	same	tools	which	is	perfect	if	you’re	transitioning	from	Photoshop	to	GIMP	or	looking	for	a	less	costly	option.

04.11.2021	·	While	Adobe	Photoshop	Lightroom	download	for	PC	may	seem	intimidating	at	first,	the	program	offers	several	learning	tools	to	make	things	easier.	Lightroom	presets	,	tutorials,	interactive	edits,	and	a	comprehensive	FAQs	section	are	just	some	of	the	tools	that	Adobe	provides	to	help	you	learn	Lightroom.	Chrome	OS	Linux	Distribution	is
a	fast	and	lightweight	open	source	operating	system	built	around	the	revolutionary	Google	Chrome	web	browser.	It	includes	GNOME	desktop	environment,	experimental	GNOME	Shell	desktop,	Google	Music	Manager,	Picasa,	LibreOffice,	GIMP,	Pidgin,	Cheese,	Wine	and	many	more.	W3Schools	offers	free	online	tutorials,	references	and	exercises	in
all	the	major	languages	of	the	web.	Covering	popular	subjects	like	HTML,	CSS,	JavaScript,	Python,	…	Verdict:	Because	of	great	number	of	free	Lightroom	tutorials	and	free	Lightroom	presets,	this	software	takes	the	first	place	in	my	list	of	the	best	photography	editing	software	for	beginners.	Adobe	Lightroom	gets	a	pretty	big	update	and	goes	to
Adobe	Lightroom	Classic	CC..	After	2018	update	in	April,	Adobe	Co	made	a	joint	effort	to	make	Camera	Profiles	an	important	part	of	…	06.04.2022	·	Top	11	Best	Photo	Repair	Software	for	PC/Mac.	What	is	the	best	photo	restoration	software	on	PC	and	Mac?	How	to	fix	corrupted	JPEG	files?	This	post	covers	the	top	ten	best	photo	repair	tools	of	2022
that	you	can	use	to	repair	damaged	pictures.	Perform	EaseUS	photo	repair	software	free	download.	06.12.2015	·	i	use	CentOS	6.2.	i	have	same	problem	like	that,	i	already	install	the	new	package	of	csh	¨Package	tcsh-6.17-19.el6_2.x86_64	already	installed	and	latest	version¨	but	when	i	type	¨csh”	or	¨tcsh¨	on	terminal,	still	at	bash	shell.	Verdict:	GIMP
is	the	most	powerful	free	photo	editor	that	can	completely	replace	Photoshop.	One	of	the	main	advantages,	except	all	of	the	above	mentioned,	is	that	the	program	supports	RAW	files..	Gimp	–	is	an	open	source	photo	editor.You	can	change	the	program	yourself,	fix	various	bugs	and	errors	that	you	noticed,	as	well	as	add	your	own	tools.
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